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Дистанционное управление
Вы можете использовать ваш переносной телефон Gigaset для доступа к вашему 
компьютеру. Адаптер Gigaset M34 USB работает как звуковая карта и позволяет 
вам слушать музыкальные записи ли интернет-радио на вашем переносном 
телефоне. Передача файлов из компьютера в переносной телефон в реальном 
времени называется потоковой передачей данных. Вы можете использовать 
переносной телефон как плеер или как микрофон для записи данных. Вы сами 
можете решить, какие функции компьютера будут выполняться на переносном 
телефоне. 

Пример: вы хотите слушать музыку в саду. Вы можете использовать ваш 
переносной телефон для доступа к программе Windows Media Player и 
воспроизведения музыки через громкоговоритель вашего переносного телефона. 

Процедура

1. В программном обеспечении M34, выберите приложение, которым вы хотите 
управлять с помощью переносного телефона.

2. Задайте команды, которые вы хотите выполнять в приложении (например, 
воспроизводить музыку).

3. Вызовите внутреннего абонента M34 USB с переносного телефона.

4. Выберите нужные функции в меню переносного телефона.
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Панель инструментов и команды меню

Программное обеспечение Gigaset M34 использует динамическую структуру 
команд меню и панели инструментов. Для каждого компонента выводятся только 
доступные команды.
Для компонента Remote control доступны следующие команды:

Меню Команда Символ Краткое описание
File Import... Импорт файла конфигурации для 

дистанционного управления (формат 
*.kma).

Export... Экспорт выбранной записи в файл 
конфигурации для дистанционного 
управления (формат *.kma).

Exit – Завершение работы программного 
обеспечения Gigaset M34.

Edit Cut Удаление выделенного текста и 
копирование его в буфер обмена 
Windows.

Copy Копирование выделенного текста в 
буфер обмена Windows.

Paste Вставка содержимого буфера обмена 
Windows в позицию курсора.

Delete Удаление все записи.

Move up Перемещение выбранной записи 
вверх на одну позицию. 

Move down Перемещение выбранной записи вниз 
на одну позицию.

Help "Component" Вызов первой страницы оперативной 
справки для выбранного компонента 
программного обеспечения 
Gigaset M34.

About – Вызов информационного окна, в 
котором указывается номер версии 
микропрограммного обеспечения, 
компонентов программного 
обеспечения и драйверов устройств.
Component info 
Выводятся номера версий отдельных 
компонентов.
System info 
Открывается окно с подробной 
информацией об операционной 
системе Windows и вашем 
компьютере.
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Конфигурирование дистанционного управления

Для дистанционного управления могут использоваться цифровые клавиши 
вашего переносного телефона и клавиши „звезда“ и „решетка“. После настройки 
в меню телефона будут выводится настроенные клавиши и закрепленные за 
ними функции.

Выбор приложений для дистанционного управления

ì Выберите опцию PC control > Remote control в дереве меню.

ì В столбце Key укажите, какая клавиша телефона будет назначена функции 
компьютера.

ì Дважды щелкните по соответствующему полю Alias для ввода названия 
приложения.

ì Введите название, например, Media Player.
ì Дважды щелкните по полю Application для задания пути к приложению.

ì Введите полный путь к приложению, например, c:\Program 
Files\Windows Media Player\wmplayer.exe. Также вы можете нажать кнопку с 
тремя точками и выбрать приложение в проводнике.
Как только поля Alias и Application будут заполнены информация передается 
в дерево меню. Активизируется кнопка со знаком вопроса.

ì Если вы хотите задать параметры запуска приложения, дважды щелкните по 
полю Parameters и ведите путь и имя файла, например, "d:\My 
Documents\My Music\Song.mp3".

Настройка дистанционного управления приложением

После выбора приложения для дистанционного управления вы должны задать, 
как будет выполняться управление приложением.

ì Нажмите на знак вопроса в правом столбце для задания команды, которая 
будет выполняться после вызова приложения.
например, для приложения Media Player, вы должны задать, какие клавиши 
будут использоваться для начала и остановки воспроизведения. также вы 
можете назначить клавишам переносного телефона функцию управления 
громкостью.
Также вы можете выполнить эти действия, нажимая не на кнопку со знаком 
вопроса, а на новую запись, которая добавляется в дерево меню. 
Открывается окно, в котором вы можете задать оставшиеся команды.

ì В столбце Key, выберите клавишу вашего телефона, которая будет 
использоваться для выполнения функции приложения.

ì Дважды щелкните по соответствующему Function для ввода названия 
функции.

ì Введите название, например, Запуск.

ì Дважды щелкните по полю Shortcut key для ввода клавиатурной команды.
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ì Ввод клавиатурной команды.
Например, в приложении Media Player, пробел (Windows 2000) или 
комбинация клавиш "CTRL + P" (Windows XP) используется для начала 
воспроизведения. В программах для Windows комбинации клавиш часто 
указываются рядом с опциями меню.

ì Нажмите OK для сохранения изменений и завершения настройки 
приложения.

Клавиатурные команды

Для ввода клавиатурной команды в поле Shortcut key нажмите соответствующую 
комбинацию клавиш. 
В этом поле одновременное нажатие клавиш SHIFT и a интерпретируется не как 
прописная буква "A", а как клавиатурная команда "SHIFT + a".

Для дистанционного управления можно использовать только те клавиатурные 
команды, которые не используются для основных функций Windows. Ввод 
клавиатурных команд, используемых Windows, например, "CTRL + ALT + 
DELETE" недопустим.

В большинстве приложений Windows клавиатурные команды указываются рядом 
с командами меню. Изучите соответствующее приложение, чтобы узнать, какие 
клавиатурные команды используются для управления его функциями.

Справка по использовании клавиатуры

Дистанционное управление возможно только для тех программ, которыми можно 
управлять с клавиатуры. Для просмотра доступных клавиатурных команд 
активизируйте дополнительную справку по использованию клавиатуры:

ì В меню „Пуск“, выберите Настройки > панель управления> 
Дополнительные возможности.

ì Откройте закладку Клавиатура.

ì Выберите опцию Отображать в программах дополнительную справку 
по использованию клавиатуры.

Клавиши управления мышью

Если во время дистанционного управления вы хотите перемещать мышь, 
включите функцию управления мышью с клавиатуры. В этом случае станет 
возможным дистанционное управление мышью.

ì В меню „Пуск“, выберите Настройки > панель управления> 
Дополнительные возможности.

ì Откройте закладку Мышь.

ì Выберите опцию Использовать клавиши мыши.

ì Если необходимо, измените настройки клавиш мыши. 
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Изменение и удаление записей

Если вы выбрали приложение для дистанционного управления, то вы можете 
изменить или удалить его. Вы можете изменять, перемещать и удалять все 
записи списка.

Изменение записи

ì Для изменения записи дважды щелкните по ней.

Перемещение записи

ì Нажмите на номер в столбце Key для выбора строки таблицы.

ì Нажимайте кнопки со стрелками для перемещения строки в таблице вверх 
или вниз.

Удаление записи

Удаление команды запуска приложения с помощью дистанционного 
управления
ì Нажмите на номер в столбце Key для выбора строки таблицы. Удерживая 

нажатой клавишу SHIFT, вы можете выбрать несколько строк подряд. 
Удерживая нажатой клавишу CTRL, вы можете выбрать несколько строк, 
расположенных в разных местах таблицы.

Или
ì Нажмите на поле, которое вы хотите удалить.

ì Нажмите кнопку удаления (кнопку X) для удаления записи.

Удаление команды управления приложением
ì Нажмите на номер в столбце Key для выбора строки таблицы. Удерживая 

нажатой клавишу SHIFT, вы можете выбрать несколько строк подряд. 
Удерживая нажатой клавишу CTRL, вы можете выбрать несколько строк, 
расположенных в разных местах таблицы.

Или
ì Нажмите на поле, которое вы хотите удалить.

ì Нажмите кнопку удаления (кнопку X) для удаления записи.
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Импортирование и экспортирование настроек

Вы можете экспортировать настройки в файл в формате *.kma, а затем 
импортировать их после изменения конфигурации вашего компьютера для 
быстрого использования функции дистанционного управления. Также вы можете 
импортировать эти настройки на другом компьютере и использовать 
дистанционное управление как обычно. 

Экспортирование настроек

ì Нажмите цифру в столбце Key для выбора экспортируемых настроек. 

ì Нажмите кнопку Export...
ì Выберите путь и имя файла для экспорта настроек. 

ì Нажмите OK.

ì Повторите эту процедуру для других настроек, которые вы хотите 
экспортировать.

Импортирование настроек

ì Нажмите кнопку Import...
ì Выберите путь и имя файла настроек.

ì нажмите OK.

Если для клавиши из импортируемого файла уже назначена другая функция, то 
выводится запрос на изменение предыдущей настройки.

ì Повторите эту процедуру для импортирования всех нужных настроек.

!

Для функционирования дистанционного управления после 
импортирования настроек необходимо, чтобы пути к программе на 
старом и новом компьютерах совпадали. Если в старой 
конфигурации программа была установлена в папке d:\Program 
Files\... , а в новой конфигурации она установлена в папке 
c:\Program Files\..., то вы должны соответственно изменить путь в 
настройках дистанционного управления. 
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Пример конфигурации
Если вы хотите использовать дистанционное управления для работы с 
программой Windows Media Player, то вы можете импортировать готовую 
конфигурацию.

ì Нажмите кнопку Import....
ì Выберите файл windows_media_player_9.kma в папке 

C:\Program Files\Gigaset DECT\gigaset-m34-software
Если при установке программного обеспечения вы выбрали другую папку, то 
этот файл будет расположен в ней.

ì Нажмите OK.
Готовая конфигурация импортирована.

ì Если необходимо, изменит конфигурацию по вашему желанию.

Использование дистанционного управления

Если вы выбрали приложение, для дистанционного управления, то вы можете 
управлять работой этого приложения с переносного телефона. Для этого вы 
должны установить внутреннее соединение между вашим переносным 
телефоном и адаптером Gigaset M34 USB.

Вызов адаптера Gigaset M34 USB

Для того чтобы соединение можно было установить, переносной телефон и 
адаптер Gigaset M34 USB должны быть зарегистрированы на одном базовом 
блоке. Для установления соединения между переносным телефоном и 
адаптером Gigaset M34 USB позвоните с переносного телефона на адаптер 
Gigaset M34 USB (внутренние соединения бесплатны).

ì Нажмите клавишу INT на переносном телефоне.

ì Выберите внутреннего абонента Gigaset M34 USB. Внутреннее название, под 
которым адаптер зарегистрирован на базовом блоке, можно посмотреть в 
настройках программного обеспечения Gigaset M34 - M34 USB > 
Configuration > Name:.

ì Для установления внутреннего соединения нажмите на переносном телефоне 
клавишу соединения или клавишу громкой связи.

!

Учтите, что во время внутреннего соединения ваш переносной 
телефон будет заблокирован для других вызовов.
Если вы включили на переносном телефоне функцию ожидания 
вызова, то при поступлении вызова вы услышите специальный 
сигнал и на дисплей будет выведено имя или абонентский номер 
вызывающего абонента (если эта функция поддерживается 
телефонной сетью). Дополнительную информацию вы найдете в 
инструкции по эксплуатации переносного телефона.
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Дистанционное управление компьютером

Меню адаптера M34 USB выводится на дисплей вашего переносного телефона. 
В этом меню вы увидите все функции, к которым вы можете получить доступ с 
переносного телефона. 

ì На переносном телефоне выберите Remote control.
Вы увидите все приложения, которые вы настроили для дистанционного 
управления в программном обеспечении Gigaset M34

ì Выберите приложение, которым вы хотите управлять.
На дисплей переносного телефона выводятся все команды, которые можно 
выполнить с помощью дистанционного управления.

ì Нажмите на переносном телефоне клавишу, соответствующую функции, 
которую вы хотите выполнить.

Если дистанционное управление больше не нужно:
ì Разорвите соединение, нажав на переносном телефоне клавишу „отбой“.
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Окно сообщений
Вы можете использовать ваш переносной телефон для просмотра сообщений, 
поступающих на ваш компьютер.

Вы можете использовать „Окно сообщений“, чтобы не сидеть перед компьютером 
во время выполнения продолжительных процедур (например, проверки на 
вирусы), но увидеть, что процедура остановлена с сообщением об ошибке.

Процедура

1. В программном обеспечении M34, выберите сообщения, которые должны 
передаваться на ваш переносной телефон.

2. При поступлении сообщения с компьютера на переносном телефоне начнет 
мигать клавиша сообщений.

3. Нажмите клавишу сообщений на переносном телефоне для соединения с 
адаптером Gigaset M34 USB.

4. Прочитайте сообщение, отправленное с компьютера. 

5. Разорвите соединение с адаптером Gigaset M34 USB.

Панель инструментов и команды меню

Программное обеспечение Gigaset M34 использует динамическую структуру 
команд меню и панели инструментов. Для каждого компонента выводятся только 
доступные команды.

Для компонента Message box доступны следующие команды:

Меню Команда Символ Краткое описание
File Exit – Завершение работы программного 

обеспечения Gigaset M34.
Edit Cut Удаление выделенного текста и 

копирование его в буфер обмена 
Windows.

Copy Копирование выделенного текста в 
буфер обмена Windows.

Paste Вставка содержимого буфера обмена 
Windows в позицию курсора.
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Настройка окна сообщений

Для просмотра только определенных сообщений с компьютера вы можете 
выбрать нужные сообщения.

Выбор сообщений

Вы можете выбрать режим информирования о всех сообщениях или только об 
определенных сообщениях.

ì Выберите опцию PC control > Message box в дереве меню.

ì Выберите опцию All, Specific или None.
All: На переносно телефон передаются извещения о всех сообщениях, 
выводимых на дисплей компьютера.
Specific: Вы получаете извещения только об определенных сообщениях см. 
"Извещения об определенных сообщениях".
None: Извещения на переносной телефон не передаются.

Извещения об определенных сообщениях

Если вы выбрали опцию Specific, то вы должны задать сообщениях, извещения 
о которых будут передаваться. 

Для этого программа обрабатывает заголовок окна и текст окна сообщения.

Help "Component" Вызов первой страницы оперативной 
справки для выбранного компонента 
программного обеспечения 
Gigaset M34.

About – Вызов информационного окна, в 
котором указывается номер версии 
микропрограммного обеспечения, 
компонентов программного 
обеспечения и драйверов устройств.

Component info 
Выводятся номера версий отдельных 
компонентов.

System info 
Открывается окно с подробной 
информацией об операционной 
системе Windows и вашем компьютере.

Меню Команда Символ Краткое описание
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Only with the following text in the header:
ì В текстовом поле введите текст для которого вы хотите получать извещения. 

Вы можете ввести несколько текстов через точку с запятой.
Пример: Предупреждение; Система; Outlook. Если вы введете эти тексты, 
то вы будете получать извещения о сообщениях программы Outlook и о 
системных предупреждениях.

Only with the following text in the message box:
ì В текстовом поле введите текст, который должен быть в окне сообщения, 

чтобы извещение об этом сообщении было передано на переносной телефон. 
Вы можете ввести несколько текстов через точку с запятой. 

Включение обеих опций
Если вы выберите обе опции, т. е. поиск заданного текста в заголовке окна и в 
тексте окна, то извещения будут передаваться на переносной телефон при 
совпадении хотя бы одного текста в обеих категориях. 

Длина сообщений

Вы может выбрать получение извещений только с заголовком окна или с 
дополнительным текстом. 

ì Выберите Show the header only, если вы не хотите, чтобы дополнительный 
текст передавался на переносной телефон. Например, для программы 
Outlook на переносной телефон будет передано извещение Microsoft 
Outlook.

Или
ì Выберите Show the header plus content to the following maximum length: 

если вы хотите, чтобы передавался дополнительный текст из окна 
сообщения. Эту опцию целесообразно использовать для предупреждений и 
сообщений об ошибках.

ì Затем введите число, определяющее количество символов, передаваемых на 
переносной телефон (допустимые значения - от 1 до 256 символов). 

i Если вы введете несколько текстов, не разделяя их точкой с 
запятой, то они рассматриваются как единый текст. 
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Использование окна сообщений

Если вы настроили приложение „Окно сообщений“ в программном обеспечении 
Gigaset M34, то на переносной телефон будут передаваться извещения о 
выбранных сообщениях. Для приема извещений установите внутреннее 
соединение с адаптером Gigaset M34 USB.

Получение извещений

При получении извещения на переносном телефоне звучит предупредительный 
сигнал и начинает мигать клавиша сообщений.

ì Нажмите клавишу сообщений на вашем переносном телефоне. 
На дисплей выводится список извещений, которые еще не были получены.

ì Выберите на переносном телефоне INT... (например, INT 2).

ì Нажмите на переносном телефоне дисплейную клавишу OK.
Устанавливается внутреннее соединение с адаптером Gigaset M34 USB. Вы 
можете прочитать извещения, полученные с компьютера.

После чтения извещения:
ì Нажмите на переносном телефоне клавишу „отбой“.

На дисплей выводится меню M34 USB.

ì Нажмите на переносном телефоне клавишу „отбой“ еще раз.
Внутреннее соединение между переносным телефоном и адаптером 
Gigaset M34 USB разрывается.

! Во время внутреннего соединения ваш переносной телефон 
заблокирован для других вызовов.
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Моментальный обмен сообщениями
Если вы установили на вашем компьютере программу моментального обмена 
сообщениями, то вы можете просматривать полученные сообщения на вашем 
переносном телефоне.

Пример: вы ждете, когда ваш друг выйдет в интернет и пошлет вам сообщение, 
но вы не хотите сидеть перед компьютером. Настройте программное 
обеспечение Gigaset M34 так, чтобы при поступлении сообщения оно было 
передано на переносной телефон. 

Процедура

1. Настройте моментальный обмен сообщениями в программном обеспечении M34.

2. При поступлении сообщения на переносной телефон будет передано извещение. 

3. Нажмите на переносном телефоне клавишу сообщений для соединения с 
адаптером Gigaset M34 USB.

4. Выберите нужную функцию в меню переносного телефона.

5. Разорвите соединение с адаптером Gigaset M34 USB.

Настройка моментального обмена сообщениями

В программном обеспечении Gigaset M34 выберите вашу программу 
моментального обмена сообщениями, введите ваше имя пользователя и пароль 
и выберите настройку, должна ли поступлении сообщений загораться клавиша 
сообщений на вашем переносном телефоне.

ì Выберите в дереве меню опцию Messenger.
ì Откройте поле выбора и выберите используемую программу моментального 

обмена сообщениями.

ì Введите ваше имя пользователя.

ì Введите ваш пароль.

ì Если необходимо, выберите опцию сохранения пароля в настройках.

ì Включите или отключите опцию мигания клавиши сообщений на переносном 
телефоне при поступлении сообщений.

Использование моментального обмена сообщениями

Если вы настроили моментальный обмен сообщениями в программном 
обеспечении M3, то на дисплей переносного телефона будет выводиться 
информация о том, кто из ваших друзей находится в режиме онлайн. Вы можете 
вводить текстовые сообщения и смотреть, поступи ли для вас новые сообщения.

Для получения извещений о поступлении новых сообщений установление 
соединения между переносным телефоном и адаптером Gigaset M34 USB не 
требуется. Если вы хотите посмотреть сообщения и использовать моментальный 
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обмен сообщениями на переносном телефоне, то нужно установить внутреннее 
соединение с адаптером Gigaset M34 USB.

При поступлении сообщения на компьютер, на переносном телефоне звучит 
сигнал и мигает клавиша сообщений.

Получение сообщений из программы моментального 
обмена сообщениями

Если вы настроили моментальный обмен сообщениями, то при поступлении 
новых сообщений на переносном телефоне мигает клавиша сообщений.

ì Нажмите клавишу сообщений на вашем переносном телефоне.
На дисплей выводится список еще не полученных новых сообщений.

ì Выберите на переносном телефоне опцию INT... (например, INT 2).

ì Нажмите на переносном телефоне дисплейную клавишу OK.
Устанавливается внутреннее соединение с адаптером Gigaset M34 USB. Вы 
можете использовать моментальный обмен сообщениями с переносного 
телефона - см. раздел «Использование моментального обмена сообщениями 
с переносного телефона» на странице 19.

После чтения сообщения:
ì Нажмите на переносном телефоне клавишу „отбой“.

На дисплей выводится меню M34 USB.

ì Нажмите на переносном телефоне клавишу „отбой“ еще раз.
Внутреннее соединение между переносным телефоном и адаптером 
Gigaset M34 USB разрывается.

! Во время внутреннего соединения ваш переносной телефон 
заблокирован для других вызовов.
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Вызов адаптера Gigaset M34 USB

Если новых сообщений нет, то вы все равно можете использовать моментальный 
обмен сообщениями с переносного телефона. Для этого установите с 
переносного телефона внутреннее соединение с адаптером M34 USB. 
Переносной телефон и адаптер Gigaset M34 USB должны быть 
зарегистрированы на одном базовом блоке. Для установления внутреннего 
соединения вызовите адаптер Gigaset M34 USB с переносного телефона.

ì Нажмите на переносном телефоне клавишу INT.

ì Выберите внутреннего абонента Gigaset M34 USB. Внутреннее название, с 
которым адаптер зарегистрирован на базовом блоке, можно посмотреть в 
программном обеспечении Gigaset M34 в настройке M34 USB > Configuration 
> Name:.

ì Для установления соединения нажмите на переносном телефоне клавишу 
соединения.

Использование моментального обмена сообщениями с переносного 
телефона

На дисплей переносного телефона выводится меню M34 USB. В этом меню 
выводятся все функции, к которым у вас есть доступ с переносного телефона.

ì Выберите на переносном телефоне функцию Messenger.
На дисплей выводится ваше имя пользователя и список ваших друзей с 
указанием их статуса.
Символ стрелки рядом с именем означает, что данный пользователь 
находится в режиме онлайн, но не работает за компьютером в данный момент.
Пользователи в режиме офлайн не выводятся в этом списке.

ì Выберите дополнительные функции с помощью дисплейных клавиш 
переносного телефона.

ì Дополнительную информацию вы найдете в инструкции по эксплуатации 
переносного телефона.

Если функция моментального обмена сообщениями с переносного 
телефона вам больше не нужна:
ì Разорвите соединение, нажав на переносном телефоне клавишу „отбой. 

! Во время внутреннего соединения ваш переносной телефон 
заблокирован для других вызовов.
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Настройка телефонных справочников
В компьютерных телефонных справочниках абонентские номера обычно 
сохраняются с кодами предварительного набора. При осуществлении вызовов по 
сетям общего пользования коды предварительного набора нужно вводить, только 
когда они необходимы.

Пример: Вы используете сеть общего пользования для набора номера с кодом 
007 для России и, например, 095 для Москвы. Соединение не будет установлено.

Поэтому абонентские номера из телефонных справочников вашего компьютера 
должны быть изменены перед передачей их в телефон. Т. е. если для набора 
номера коды предварительного набора не нужны, то их следует удалить перед 
передачей номера в телефон. 

Пример: Вы живете в Москве (код 095). В вашем компьютерном телефонном 
справочнике есть запись "Петр Иванов" с абонентским номером "095-1234567". 
Программное обеспечение Gigaset M34 должно передать в переносной телефон 
только номер "1234567".

Вы должны настроить коды предварительного набора в программном 
обеспечении Gigaset M34 для гарантирования правильной передачи абонентских 
номеров в переносной телефон.

Настройка абонентских номеров для переносного 
телефона

ì Выберите в дереве меню опцию Directories > Configuration.

ì Если необходимо, введите ваш собственный код выхода в город в поле 
Access code (PABX).

ì В поле International access code, введите код международной связи для 
вашей страны, например, (8 для России).

ì В поле Own country code, введите код вашей страны (7 для России).

ì В National access code введите ваш код города без первых нулей (например, 
95 для Москвы, 812 для Санкт-Петербурга).

ì Посмотрите пример преобразования:

1. Own local area:
Если абонентский номер в телефонном справочнике начинается с такого же 
кода города, как номер вашего базового блока, выводится только сам 
абонентский номер. Коды не выводятся.

2. Own country :
Если абонентский номер в телефонном справочнике начинается с такого же 
кода страны, как номер вашего базового блока, выводится абонентский номер 
и код города. Код международной связи и код страны не выводятся. 

3. Foreign country:
Если у абонентского номера в телефонном справочнике другой код страны, то 
выводится полный абонентский номер с кодом международной связи.
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Настройка отображения имен для переносного телефона

Вы можете выбрать формат вывода абонентских номеров и имен на дисплей 
переносного телефона. В этом случае все записи будут иметь одинаковую 
структуру, что позволит избежать долгого поиска в телефонном справочнике 
переносного телефона.

Отображение имен на дисплее переносного телефона

ì Выберите одну из трех опций:

– Both first name and last name: На дисплей будут выводиться имя и 
фамилия.

– Last name only: На дисплей будет выводиться только фамилия.
– First name only: На дисплей будет выводиться только имя.

Сортировка имен

ì Выберите одну из двух опций:

– Last name, First name: На дисплей будет выводиться сначала фамилия, а 
затем имя. Это означает, что сортировка записей в телефонном 
справочнике будет осуществляться по фамилии. 

– First name, Last name: На дисплей будет выводиться сначала имя, а затем 
фамилия. Это означает, что сортировка записей в телефонном 
справочнике будет осуществляться по имени.

Длина записей

Максимальная длина записей для переносных телефонов Gigaset - 16 символов. 
Два из этих символов - пробелы. Один между именем и фамилией и один между 
именем и типом абонентского номера (например Р для рабочего телефона, Д для 
домашнего телефона и т. д.). Это означает, что для имени и фамилии остается 
только 13 символов. 

ì Выберите режим автоматического или ручного сокращения имени и фамилий:

– Automatic: На дисплей переносного телефона выводятся 13 первых 
символов, например. Mustermann Fr).

– Manual: Задайте количество символов для имени и для фамилии 
(например, 7 символов для фамилии и 6 символов для имени: Musterm 
Friedr)
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Удаление телефонного справочника переносного 
телефона перед получением новых записей

ì Выберите настройку, должен ли телефонный справочник переносного 
телефона удаляться перед передачей телефонного справочника из 
компьютера.
Yes: телефонный справочник переносного телефона будет удаляться перед 
каждой передачей телефонного справочника. Выберите эту опцию, если вы 
ведете телефонный справочник для ваших переносных телефонов только на 
компьютере. 
No: Телефонный справочник переносного телефона никогда не будет 
удаляться перед передачей новой версии. Выберите эту опцию, если вы 
хотите регулярно редактировать телефонный справочник в переносном 
телефоне.
Ask: При передаче телефонного справочника из компьютера выводится 
запрос, хотите ли вы удалить телефонный справочник переносного телефона. 
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Телефонные справочники
Программное обеспечение Gigaset M34 поддерживает различные функции 
редактирования и управления телефонными справочниками. Вы можете 
изменять телефонные справочники на компьютере, а затем передавать их в 
переносные телефоны. Для этого не нужно создавать на компьютере 
дополнительные справочники, так как программное обеспечение Gigaset M34 
работает непосредственно со стандартными телефонными справочниками. 

u Address Book (WAB): адресная книга MS Outlook Express
u Outlook: папка Контакты из офисного компонента MS Outlook
При запуске программного обеспечения Gigaset M34 проверяется, какие 
адресные книги есть в компьютере. После этого найденные адресные книги 
становятся доступны, как источники данных для телефонного справочника 
переносного телефона.

Это взаимодействие программного обеспечения Gigaset M34 и программ 
Microsoft дает следующие преимущества:

u Вы можете как обычно обновлять и управлять адресной книгой в вашей 
почтовой программе. 

u Программное обеспечение Gigaset M34 считывает из этих программ все 
записи, содержащие телефонные номера.

u Вы создаете телефонные справочники для ваших переносных телефонов в 
программном обеспечении Gigaset M34. Если в ваших переносных телефонах 
должны быть разные телефонные справочники, то вы можете создать списки 
рассылки для отдельных переносных телефонов. 

u Вы передаете записи телефонного справочника в переносные телефоны. 
u Даже, если вы не пользуетесь программами Outlook или Outlook Express, вы 

можете редактировать телефонные справочники переносных телефонов на 
компьютере и копировать их из одного переносного телефона в другой.
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Выбор компьютерных справочников

ì Вберите в дереве меню опцию Directories.
Дерево меню раскрывается и на дисплей выводится окно настройки, 
компьютерные телефонные справочники и телефонные справочники всех 
переносных телефонов, зарегистрированных на том же базовом блоке, что и 
адаптер Gigaset M34 USB.

ì Выберите компьютерный телефонный справочник Address Book или 
Outlook.
В рабочей области выводятся записи из выбранного телефонного 
справочника.

Программное обеспечение Gigaset M34 считывает из компьютерных телефонных 
справочников следующие данные:

u Last name: Фамилия, сохраненная в программах Microsoft. После записи Last 
name в скобках указывается общее количество записей в выбранной 
адресной книге.

u First name: Имя сохраненное в программах Microsoft.
u Type: Тип телефонного номера. Доступные типы:

– B: Рабочий телефонный номер.
– P: Домашний телефонный номер.
– M: Мобильный телефонный номер.
– ?: Телефонный номер, тип которого нельзя определить.

u Number: Телефонный номер заданного типа.
u Anniversary: День рождения, сохраненный в программах Microsoft.
u VIP: Записи со статусом VIP.

Сортировка записей телефонного справочника

Вы можете сортировать записи телефонного справочника по категориям.

ì Нажмите на заголовок нужной категории для сортировки записей по этой 
категории.
Пример: Вы нажали заголовок категории First name. Записи телефонного 
справочника сортируются в алфавитном порядке по имени.

ì Для выбора обратного порядка сортировки нажмите заголовок еще раз. 
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Настройка режима просмотра

Для сравнения телефонного справочника переносного телефона с телефонным 
справочником компьютера вы можете вывести на экран два справочка рядом или 
один под другим. 

Просмотр телефонных справочников

ì Нажмите в меню опцию View.

ì Выберите одну из опций:
Single window: В рабочей области выводится только один активный 
телефонный справочник.
2 windows vertical: Два активных телефонных справочника выводятся радом.
2 windows horizontal: Два активных телефонных справочника выводятся 
один под другим.

Предварительный просмотр

В режиме предварительного просмотра в рабочей области открывается 
дополнительное окно. В этом окне выводится выбранная запись.

ì Выберите в меню опцию View > Preview для включения режима 
предварительного просмотра. 

Получение телефонного справочника из переносного 
телефона

Телефонные справочники компьютера считываются автоматически, а 
телефонные справочники переносных телефонов нужно загружать в 
программное обеспечение Gigaset M34 вручную. 

ì Нажмите на телефонный справочник переносного телефона. 
Выводится запрос, хотите ли вы считать этот справочник из переносного 
телефона.

ì Нажмите Да для чтения телефонного справочника.
При установлении соединения с адаптером Gigaset M34 USB на переносном 
телефоне звучит специальный сигнал. Телефонный справочник переносного 
телефона передается в компьютер. После окончания передачи соединение 
автоматически разрывается.
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Создание и отправка телефонных справочников

Вы можете передавать записи телефонного справочника из компьютера (из 
адресной книги (Outlook и Windows) в переносной телефон и передавать записи 
из одного переносного телефона в другой.

Пример: Передача телефонного справочника из Outlook в переносной телефон.

ì Выберите режим просмотра, при котором на экран выводятся оба 
телефонных справочника - телефонный справочник компьютера и 
телефонный справочник переносного телефона.

ì Нажмите на запись телефонного справочника компьютера и, удерживая 
кнопку мыши нажатой, переместите ее в окно телефонного справочника 
переносного телефона. 

ì Повторите эту процедуру для всех записей, которые вы хотите передать в 
переносной телефон.

ì Выберите в меню опцию Options > Send для отправки записей телефонного 
справочника.
При установлении соединения с адаптером Gigaset M34 USB на переносном 
телефоне звучит специальный сигнал. Телефонный справочник передается в 
переносной телефон. После окончания передачи соединение автоматически 
разрывается.

Изменение компьютерных телефонных справочников

Вы можете изменять компьютерные справочники с помощью программ Windows 
Address Book или Outlook. После внесения изменений в один из этих 
справочников компонент Directories программного обеспечения Gigaset M34 
обновляется. Считывать компьютерные справочники вручную не нужно.

Адресная книга Windows

1-й Вариант:
ì Вызовите программу MS Outlook Express.

ì Выберите в меню Инструменты > Адресная книга .
ì Для изменения записи дважды щелкните по ней.

2-й Вариант:
ì Выберите Пуск > Выполнить.

ì Введите wab.

ì Для изменения записи дважды щелкните по ней.
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Outlook

ì Откройте MS Outlook > Контакты.

ì Для изменения записи дважды щелкните по ней.

Изменение телефонных справочников переносных 
телефонов

Вы можете изменять телефонные справочники переносных телефонов в самих 
телефонах или в программном обеспечении Gigaset M34.

Изменение записей телефонного справочника

ì Выберите м дереве меню опцию Directories.
В дереве меню выводятся доступные справочники. 

ì Выберите в дереве меню переносной телефон (например., Int 3).
Загружается телефонный справочник выбранного телефона.

ì Дважды щелкните по записи.
Открывается окно с полями: Last name, First name, Type, Number, 
Anniversary, VIP.

ì Изменит запись.

ì Нажмите OK для сохранения внесенных изменений в программе Gigaset M34.

ì Выберите в дереве меню опцию Options > Send.
Измененный телефонный справочник передается в переносной телефон.

!
Изменения записей телефонного справочника переносного 
телефона не передается в переносной телефон автоматически. 
Сначала все изменения сохраняются только в программном 
обеспечении Gigaset M34, и их следует передать в переносной 
телефон до завершения работы с программой.
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Панель инструментов и команды меню

Программное обеспечение Gigaset M34 использует динамическую структуру 
команд меню и панели инструментов. Для каждого компонента выводятся только 
доступные команды.

Для компонента Directories доступны следующие команды:

Меню Команда Символ Краткое описание
 File Print Печать телефонного справочника.

Distribution 
list

– Создание списка контактов для 
передачи в переносной телефон.

Exit – Выход из программы Gigaset M34.
Edit Cut Удаление выделенного текста и 

копирование его в буфер обмена 
Windows.

Copy Копирование выделенного текста в 
буфер обмена Windows.

Paste Вставка содержимого буфера обмена 
Windows в позицию курсора.

New entry Создание новой записи телефонного 
справочника.

Edit Изменение записи телефонного 
справочника.

Delete Удаление.

View Single window Настройка вывода информации в 
рабочей области. Выбор режима 
одновременного вывода двух 
телефонных справочников для 
копирования записей из одного в 
другой.

2 windows 
vertical
2 windows 
horizontal

Preview Вывод всех данных записи в рабочей 
области.

Options Send Передача телефонного справочника в 
переносной телефон.

Receive Получение телефонного справочника 
из переносного телефона.
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Редактирование с помощью контекстного меню:
ì Щелкните правой кнопкой мыши по записи телефонного справочника 

переносного телефона.

ì К контекстном меню выберите одну из опций: Distribution..., Cut, Copy, Paste, 
New entry, Edit, Delete.

Категории записей телефонного справочника переносного 
телефона.

Для назначения категорий записей телефонного справочника переносного 
телефона (Д, Р или М) после имени введите пробел и прописную букву. 
Например, Петр Иванов Д для домашнего телефон Петра Иванова.

Список рассылки

Вы можете создать список рассылки для отправки разных записей телефонного 
справочника в разные переносные телефоны.

Пример: один из ваших переносных телефонов обычно находится в гостиной, а 
другой в офисе. В гостиной вам нужны телефонные номера друзей, а в офисе 
бизнесс-партнеров. Вам не нужно создавать телефонные справочники для 
каждого телефона, вы можете создать список рассылки и использовать его.

Мастер создания списка рассылки поможет вам в создании списков. 

Help "Component" Вызов первой страницы оперативной 
справки для выбранного компонента 
программного обеспечения 
Gigaset M34.

About – Вызов информационного окна, в 
котором указывается номер версии 
микропрограммного обеспечения, 
компонентов программного 
обеспечения и драйверов устройств.

Component info 
Выводятся номера версий отдельных 
компонентов.

System info 
Открывается окно с подробной 
информацией об операционной 
системе Windows и вашем 
компьютере.

Меню Команда Символ Краткое описание
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Использование мастера списков рассылки

ì Выберите в дереве меню опцию Directories.

ì Выберите в меню опцию File > Distribution.... 
Открывается окно мастера списков рассылки.

Функции мастера списков рассылки: создание нового списка рассылки, удаление 
списка рассылки, копировании, переименование и изменение списка рассылки. 
Для создания нескольких похожих, но не одинаковых телефонных справочников 
переносных телефонов, выполните следующие действия:

1. Создайте список рассылки, содержащий записи, которые должны быть 
переданы во все переносные телефоны.

2. Скопируйте этот список рассылки.

3. Переименуйте список рассылки.

4. Измените список рассылки для первого переносного телефона. 

5. Вернитесь к первому созданному списку рассылки, скопируйте и 
переименуйте его, а затем измените для второго переносного телефона и т. д.

Создание нового списка рассылки

ì Нажмите кнопку New для создания нового списка рассылки.

ì Введите название нового списка рассылки.

ì Нажмите OK.
Новый список рассылки создается и выводится на экран. 

Изменение списка рассылки

ì Выберите список рассылки.

ì Нажмите опцию Members...
На экран выводится содержание списка рассылки.

ì Нажмите Add entry для добавления в список рассылки других контактов. 

ì Выберите адресную книгу, из которой вы хотите добавить контакты. 

ì Выберите контакт, а затем нажмите кнопку со стрелкой для копирования 
контакта. 

ì По очереди добавьте все нужные контакты. 

ì Нажмите OK для завершения выбора.
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Передача списка рассылки

Требование
Создан новый список рассылки или выбран существующий список рассылки.

Процедура
ì Нажмите кнопку > для передачи списка рассылки.

На экран выводится список всех зарегистрированных переносных телефонов.

ì Выберите в списке переносной телефон.

ì Нажмите Send для отправки списка рассылки в выбранный переносной 
телефон.
В окне состояния указывается, сколько записей уже передано.

ì Когда передача будет завершена, нажмите Done.

Удаление списка рассылки

ì Выберите в дереве меню опцию Directories.

ì Выберите в меню опцию File > Distribution....
Открывается мастер списков рассылки.

ì Выберите список рассылки, который вы хотите удалить.

ì Нажмите Delete.

ì Подтвердите запрос, нажав Yes.
Список рассылки удаляется.

Переименование списка рассылки

ì Выберите в дереве меню опцию Directories.

ì Выберите в меню опцию File > Distribution....
Открывается мастер списков рассылки.

ì Выберите список рассылки, который вы хотите переименовать.

ì Нажмите Rename.

ì Введите новое название.

ì Нажмите OK.
Список рассылки выводится в перечне с новым названием. 
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Текстовые сообщения SMS
Вы можете использовать базовый блок Gigaset для отправки приема текстовых 
сообщений SMS. Программное обеспечение Gigaset M34 позволяет вам вводить 
сообщения и управлять сообщениями на компьютере. Это означает, что вы 
можете пользоваться сообщениями SMS также, как электронной почтой. В 
программном компоненте SMS вы можете посмотреть сообщения SMS вашего 
базового блока, и выполнять операции сортировки, архивирования, создания и 
удаления сообщений.

Сообщения SMS и EMS

SMS (Short Message Service) - это служба, используемая для отправки текстовых 
сообщений с одного телефона на другой. раньше эта услуга была доступна 
только для мобильных телефонов, однако сейчас сообщения SMS можно 
передавать и принимать по обычным телефонным сетям. Длина сообщений SMS 
ограничена 140 байтами (140 байтов = 160 символов по 7-бит или 140 символов 
по 8 бит). 

Для отправки длинных сообщений используется Enhanced Message Service 
(EMS). В сообщениях EMS кроме текста можно передавать рисунки и звуки. 
Однако базовый блок не может обрабатывать рисунки и звуки, и они выводятся 
как текст. При отправке и приеме сообщения EMS разделяются на несколько 
частей (сообщений SMS).  При получении сообщение EMS на базовом блоке оно 
составляется из этих отдельных сообщений SMS.  Если передать все части 
сообщения EMS невозможно, то будет выведено сообщение, какие части 
пропущены. 
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Программное обеспечение Gigaset M34 и сообщения SMS

Вы можете вводить, отправлять и принимать сообщения SMS с помощью 
переносного телефона или компьютера PC. Кроме того, на компьютере вы 
можете управлять текстовыми сообщениями и архивировать их. 

ì Запустите Gigaset M34 Software.

ì Выберите в дереве меню опцию SMS. 

Панель инструментов и команды меню

Программное обеспечение Gigaset M34 использует динамическую структуру 
команд меню и панели инструментов. Для каждого компонента выводятся только 
доступные команды.

Для компонента SMS доступны следующие команды:

Меню Команда Символ Краткое описание
File New Создание нового сообщения SMS и 

вызов окна редактора.

Archive Сохранение сообщений SMS из 
переносного телефона в компьютер.

Print All / Print 
Selection

Печать. 

Exit – Завершение работы с программой 
Gigaset M34.

Edit Edit SMS Редактирование.

Answer Ответ.

Transfer Переадресация.

Delete Удаление.

Options Update Обновление.
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Спписки SMS

Help "Component" Вызов первой страницы оперативной 
справки для выбранного компонента 
программного обеспечения 
Gigaset M34.

About – Вызов информационного окна, в 
котором указывается номер версии 
микропрограммного обеспечения, 
компонентов программного 
обеспечения и драйверов устройств.
Component info 
Выводятся номера версий отдельных 
компонентов.
System info 
Открывается окно с подробной 
информацией об операционной 
системе Windows и вашем 
компьютере.

Inbox (phone) Вы можете просматривать текстовые сообщения, 
полученные вашим базовым блоком. Эти 
сообщения еще не сохранены в компьютере. 
Программа получает список непосредственно от 
базового блока. При удалении сообщений из этого 
списка они удаляются из памяти базового блока.
В списке указываются отправитель сообщения SMS 
и дата отправки. Если вы зарегистрировали базовый 
блок ISDN, то также указывается получатель 
(множественный абонентский номер MSN), 
которому было отправлено сообщение.

PC mailbox > Sent В этой папке вы можете посмотреть все сообщения 
SMS, отправленные с вашего компьютера. 
Сообщения SMS, введенные и отправленные с 
переносного телефона, не выводятся в этом списке.

 PC mailbox > Drafts В этой папке вы можете посмотреть все сообщения 
SMS, введенные на компьютере, но не 
отправленные. Вместо даты отправки указывается 
Save as SMS draft.

 PC mailbox > Outbox Как и в почтовой программе сообщения временно 
сохраняются в папке Outbox. В папке Outbox, 
хранятся введенные на компьютере сообщения 
SMS, которые будут отправлены при установлении 
соединения. После того, как сообщение отправлено, 
оно перемещается в папку Sent.

 PC mailbox > Archive Вы можете переместить полученные сообщения 
SMS в эту папку.

Меню Команда Символ Краткое описание
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Архивирование сообщений SMS

Вы можете выполнить на компьютере архивирование сообщений, полученных на 
переносном телефоне. 

ì Открой те папку Inbox (phone).
ì Выберите сообщение, которое вы хотите архивировать. 
Или
ì Удерживайте нажатой клавишу CTRL и по очереди выберите сообщения SMS, 

которые вы хотите архивировать.

ì В меню выберите опцию File > Archive.

Все выбранные сообщения SMS перемещаются из папки Inbox (phone) в 
папку Archive.

Печать сообщений SMS

С помощью программного обеспечения Gigaset M34 вы можете печатать 
сообщения SMS. Вы можете распечатать все сообщения SMS или выбрать для 
печати отдельные сообщения. 

ì Откройте папку, в которой находятся сообщения SMS, которые вы хотите 
распечатать.

Печать всех сообщений SMS
ì В меню выберите опцию File > Print All.

Все сообщения SMS из выбранной папки печатаются на принтере Windows по 
умолчанию.

Печать отдельных сообщений SMS
ì Удерживайте нажатой клавишу CTRL и по очереди выберите сообщения SMS, 

которые вы хотите напечатать.

ì В меню выберите опцию File > Print Selection.
Выбранные сообщения SMS печатаются на принтере Windows по умолчанию. 
Для печати каждого сообщения на отдельном листе бумаги печатайте 
сообщения по одному.
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Удаление сообщений SMS

ì Откройте папку, сообщения из которой вы хотите удалить.

ì Выберите сообщение, которое вы хотите удалить.
Или
ì Удерживайте нажатой клавишу CTRL и по очереди выберите сообщения SMS, 

которые вы хотите удалить.

ì В меню выберите опцию Edit > Delete.
Все выбранные сообщения SMS перемещаются в корзину Windows.

Обновление данных

Когда вы открываете папку Inbox (phone), в компьютер считываются данные SMS 
из базового блока. После перемещения сообщений из папки входящих в архив, 
выводимые на дисплей данные могут обновляться с задержкой. В этом случае 
сообщения выводятся в папке Inbox (phone), хотя они уже перемещены в архив. 
Обновите данные для повторного считывания сообщений из базового блока. 

ì В меню выберите Options > Update.

Или
ì Нажмите клавишу F5.

Создание сообщений SMS н компьютере

Вы можете вводить новые сообщения SMS, отвечать на принятые сообщения 
SMS или переадресовывать принятые сообщения SMS.

Ввод сообщений SMS

Открывается окно редактора для ввода сообщения SMS. 

! При удалении сообщений SMS из папки Inbox (phone), сообщения 
больше не выводятся в списках телефона.

New Новое сообщение с пустыми полями адреса и текста.

ì Выберите в меню опцию File > New.
Answer Ответ на принятое сообщение SMS.  В поле адреса содержится 

имя получателя, поле текста пусто.

ì Нажмите на сообщение SMS, на которое вы хотите ответить.

ì Выберите в меню опцию Edit > Answer.
Transfer Переадресация принятого сообщения SMS. поле адреса пусто, 

в поле текста содержится принятое сообщение SMS.

ì Нажмите на сообщение SMS, которое вы хотите 
переадресовать.

ì Выберите в меню опцию Edit > Transfer.



37

Текстовые сообщения SMS

Gigaset M34 USB App / Russ / A31008-M403-R102-x4-5619 / SMS.FM / 03.08.2006
S

ch
ab

lo
ne

 2
00

5_
07

_2
7

Изменение сообщения SMS
Сообщения SMS, которые вы сохранили в папке Drafts, можно открыть, изменить 
и, если необходимо, отправить позднее. 

ì Откройте папку PC mailbox > Drafts.

ì Выберите сообщение, которое вы хотите изменить и/или отправить.

ì Выберите в меню опцию Edit > Edit SMS.
Сообщение SMS открывается для изменения.

Или
ì Дважды щелкните по сообщению, которео вы хотите изменить и/или 

отправить. Сообщение SMS открывается для изменения.

Редактор сообщений SMS

Редактор сообщений SMS - это текстовый редактор, похожий на редактор 
Windows. Кроме обычных функций редактирования редактор сообщений SMS 
подсчитывает количество символов в текущем сообщении. То позволяет вам во 
время ввода сообщения определить, можно ли введенный текст отправить как 
одно простое сообщение SMS, или для этого потребуется длинное сообщение 
EMS.  Так как при отправке сообщения EMS разделяются на несколько 
сообщений SMS, их отправка стоит дороже. 
Панель инструментов и команды меню
В редакторе SMS доступны следующие команды меню:

Меню Команда Символ Краткое описание
File Send Перемещение сообщение в папку 

Outbox и его отправка из этой папки. 
Опция Send не активна, если поле 
адреса пусто. 

Save Перемещение сообщения в папку 
Drafts.

Print Печать сообщения на стандартном 
принтере Windows.

Close – Выход из редактора SMS.
Edit Cut Удаление выделенного текста и 

копирование его в буфер обмена 
Windows.

Copy Копирование выделенного текста в 
буфер обмена Windows.

Paste Вставка содержимого буфера обмена 
Windows в позицию курсора.
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Ввод сообщений SMS

ì Нажмите кнопку To:.
Открывается адресная книга.

ì Если необходимо, выберите адресную книгу.

ì Нажмите мышью на имя получателя. 

ì Нажмите кнопку со стрелкой для перемещения выбранного имени в поле To:.
ì Если необходимо, выберите нескольких получателей и добавьте их в поле To.

ì Нажмите кнопку OK для завершения выбора получателей.

Ввод текста
ì Нажмите текстовое поле и введите сообщение. 

В строке состояния окна редактора выводится следующая информация.

Help "Component"

 

Вызов первой страницы оперативной 
справки для выбранного компонента 
программного обеспечения 
Gigaset M34.

About – Вызов информационного окна, в 
котором указывается номер версии 
микропрограммного обеспечения, 
компонентов программного 
обеспечения и драйверов устройств.
Component info 
Выводятся номера версий отдельных 
компонентов.
System info 
Открывается окно с подробной 
информацией об операционной 
системе Windows и вашем 
компьютере.

i
Если вы выбрали более одного получателя, то каждому получателю 
отправляется отдельное сообщение SMS. Все отправленные 
сообщения SMS сохраняются в папке Sent.

Remaining characters: В этом поле указывается количество символов, 
которые вы еще можете ввести.

Number of SMS: Количество сообщений SMS, необходимое для 
отправки введенного вами текста. Также указывается 
максимальное количество сообщений SMS, которые 
могут быть скомбинированы в сообщение SMS. Это 
число зависит от возможностей вашего базового блока.

Меню Команда Символ Краткое описание
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При вводе сообщений цвет текста показывает, на сколько сообщений SMS будет 
разбит текст, при отправке сообщения. Тест первого сообщения SMS черный. Как 
только вы введет больше символов, чем можно отправить в одном сообщении 
SMS, цвет текста изменится на зеленый. Также цвет будет изменяться при 
достижении третьего и четвертого сообщений SMS. Таким образом по цвету 
вводимого текста можно точно узнать, сколько сообщений SMS понадобится для 
отправки.

Если длина сообщения EMS достигнет размера черрыех сообщений SMS, вы 
услышите предупредительный сигнал. Дальнейший ввод текста будет 
невозможен.

Отправка сообщений SMS

ì В меню редактора выберите опцию File > Send.

Окно редактора закрывается и соощдение сохраняется в папке Outbox. Как 
только сообщение будет передано базовым блоком, оно перемещается в папку 
Sent. 
Если вы не хотите отправлять введенное сообщение, закройте окно редактора. 
Открывается окно, в котором вы можете выбрать опцию сохранения введенного 
текста, как черновика. Также вы можете использовать команду меню File > Save 
для сохранения сообщения в папке Drafts.

Если вы сохранили сообщение как черновик, то вы можете отправить его позже. 
Если вы не сохранили сообщение, как черновик, то оно удаляется.

Печать сообщений SMS

Вы можете распечатать открытое сообщение SMS.

ì Выберите в меню опцию File > Print.
Сообщение печатается на принтере, который вы выбрали, как принтер Windows 
по умолчанию. 

i
В окне редактора вы можете вырезать, копировать и вставлять 
текст. Это означает, что вы, например, можете вставить в сообщение 
SMS текст, полученный на компьютере по электронной почте.



40

Блокировщик набора

Gigaset M34 USB App / Russ / A31008-M403-R102-x4-5619 / Dialer_blocker.fm / 03.08.2006
S

ch
ab

lo
ne

 2
00

5_
07

_2
7

Блокировщик набора
Если при установке программного обеспечения Gigaset M34 вы выбрали базовый 
блок ISDN, то блокировщик набора устанавливается автоматически.

Блокировщик набора служит для защиты от программ установления соединений, 
контролируя все исходящие соединения компьютера, использующие ваш 
базовый блок. Если блокировщик прерывает набор, выводится сообщение с 
указанием телефонного номера. Программа установления соединения также 
может выводить сообщение об ошибке.
Дополнительную информацию о функциях программ установления соединения 
вы найдете в разделе «Что такое программы установления соединения?» на 
странице 41.

Меры предосторожности
Блокировщик набора
При стандартных настройках блокировка установления нежелательных 
соединений отключена в программном обеспечении Gigaset M34.

u Включите блокировку набора для защиты от установления нежелательных 
соединений.

u Блокировщик набора не контролирует соединения, устанавливаемые с 
переносного телефона или из компьютерного телефонного справочника 
(ассоциативный набор).

Широкополосные соединения (DSL)
При установке программного обеспечения Gigaset M34 устанавливаются 
драйвера ISDN, которые позволяют компьютеру устанавливать модемные 
соединения (например, для разговора по телефону или доступа в интернет). Эти 
ISDN-соединения могут устанавливаться параллельно широкополосным (DSL) 
соединениям.
u Программы установления соединениями могут использовать доступные 

ISDN-соединения без предупреждения, если вы используете для доступа в 
интернет только широкополосные соединения. 
В этом случае вы должны включить блокировщик набора.

!

Защита от программ установления соединения отключена после 
установки и сначала ее нужно настроить с помощью программного 
обеспечения Gigaset M34. Настройте блокировщик набора, что 
получить надежную защиту от нежелательного установления 
соединений.

Смотри раздел «Настройка блокировщика набора» на странице 42.
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Отказ от ответственности
Используйте блокировщик набора на свой риск.
Фирма Siemens Home and Office Communication Devices GmbH & Co. KG не несет 
никакой ответственности и не предоставляет никаких гарантий, связанных с 
использованием этой программы, включая ее совместное использование с 
другой продукцией.

Что такое программы установления соединения? 

Программы установления соединения служат для установления интернет- 
соединения или соединения с факс-сервером по заданному телефонному 
номеру.

При настройке модемного доступа для подключения к интернет-провайдеру вы 
должны ввести его телефонный номер. В принципе, вы настраиваете программу 
установления соединения, зная телефонный номер и тарифы на соединение. 

Однако, существуют программы установления соединения, которые незаметно 
устанавливаются на компьютер, а затем устанавливают соединения по очень 
высоким тарифам. Такие программы установления соединения могут 
маскироваться в загружаемом программном обеспечении, например, для запуска 
вирусов. Обычно признаками таких программ установления соединения 
являются:

u Установка осуществляется в фоновом режиме, программа не видна во время 
и после установки. Это делает невозможным нормальное удаление 
программы.

u Телефонный номер задан в программе и не может быть изменен. Соединение 
устанавливается по специальному номеру с высоким тарифом или по 
международному номеру. 

u Соединение устанавливается без предупреждения, поэтому трудно 
определить его продолжительность.
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Настройка блокировщика набора

Перед включением блокировщика набора для защиты от нежелательных 
соединений его нужно настроить. Для этого вы должны знать, какие соединения 
следует разрешать, а какие запрещать. При настройке блокировщика набора вы 
можете создать список разрешенных соединений. Соединения, которые вы не 
включите в этот список будут запрещены и их установление будет невозможно. 

Настройка блокировщика набора

После установки блокировщик набора отключен по умолчанию, поэтому он не 
влияет на работу вашего компьютера. Для включения защиты от 
несанкционированного установления соединений вы должны изменить эту 
настройку.

ì Запустите программное обеспечение Gigaset M34 для настройки 
блокировщика набора.

ì Выберите в дереве меню опцию DialerBlocker. В рабочей области выводится 
текущая настройка блокировщика набора.

ì Задайте уровень безопасности. Вы можете выбрать одну из трех настроек:

Do not allow outgoing calls 
Защита от установления соединений включена.
Запрещены все соединения с компьютера через базовый блок ISDN. При 
выборе этой настройки соединение с интернетом через базовый блок Gigaset 
невозможны. 

Allow outgoing calls to these numbers
Защита от установления соединений включена. 
Создайте список разрешенных соединений. Соединения будут возможны 
только с номерами из этого списка. (например, номерами провайдеров, служб 
передачи факсов и SMS и т. д.). 

i

Рекомендации для использующих DSL-соединение
Если для подключения к интернету используется DSL, то 
обеспечиваемое адаптером Gigaset M34 USB соединение ISDN не 
нужно. Вы можете отключить соединение ISDN и таким образом 
защититься от программ установления соединения. 

ì Нажмите Пуск > Настройки > Управление системой> 
Оборудование системы> Оборудование > Менеджер 
устройств > Сетевые адаптеры.

ì Нажмите правой кнопкой мыши запись ISDN WAN driver и 
выберите в контекстном меню опцию Отключить.

В этом случает соединения ISDN будут отключены, но не удалены. 
Если потом вы захотите установить соединение через адаптер 
Gigaset M34 USB, снова активизируйте этот драйвер.
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– В столбце Number введите телефонные номера или блоки номеров, 
соединения с которым должны быть разрешены. 
Введите последовательности цифр для каждой записи. Максимальная 
длина телефонного номера - 32 цифры. Ввод специальных символов не 
разрешен. 

– В столбце Description, вы можете ввести краткое описание каждого 
телефонного номера, чтобы потом можно было легко узнать его 
назначение. 
Максимальная длина описания - 255 символов.

– Если вы хотите ввести больше 5 номеров, используйте полосы прокрутки.
Вы можете изменять и дополнять этот список в любое время.

Allow all outgoing calls (no dialer protection) 
Защита от установления нежелательных соединений отключена (настройка 
по умолчанию). 
С компьютера могут устанавливаться любые соединения.

ì Выберите в дереве меню другую опцию или завершите работу с программой 
Gigaset M34.
Новая настройка блокировщика набора сохраняется. Если выбрана защита от 
установления нежелательных соединений, она включается. 

Символы на панели задач

При включении защиты на панели задач выводится символ блокировщика набора 
(рядом с часами).

Защита от установления нежелательных соединений включена с 
текущим уровнем безопасности и запускается автоматически после 
каждой загрузки компьютера. 

ì Для вызова диалога настройки блокировщика набора дважды 
щелкните мышью по этому символу.
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Панель инструментов и команды меню

Программное обеспечение Gigaset M34 использует динамическую структуру 
команд меню и панели инструментов. Для каждого компонента выводятся только 
доступные команды.

В диалоге настройки блокировщика набора доступны следующие команды:

Меню Команда Символ Краткое описание
File Exit – Выход из программы Gigaset M34.
Edit Cut 

 

Удаление выделенного текста и 
копирование его в буфер обмена 
Windows.

Copy 

 

Копирование выделенного текста в 
буфер обмена Windows.

Paste 

 

Вставка содержимого буфера обмена 
Windows в позицию курсора.

Help "Component"

 

Вызов первой страницы оперативной 
справки для выбранного компонента 
программного обеспечения 
Gigaset M34.

About – Вызов информационного окна, в 
котором указывается номер версии 
микропрограммного обеспечения, 
компонентов программного 
обеспечения и драйверов устройств.
Component info 
Выводятся номера версий отдельных 
компонентов.
System info 
Открывается окно с подробной 
информацией об операционной 
системе Windows и вашем 
компьютере.
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Интернет-телефония
Если вы приобрели программное обеспечение Gigaset M34 с компонентом 
Skypeто вы можете подготовить ваш компьютер к установлению телефонных 
соединений через интернет.

Не компьютере следует установить программное обеспечение 
Skype.Программное обеспечение находится на прилагаемом компакт-диске, 
также его можно найти в интернете по адресу:
http://www.skype.com. 

u Дополнительно установите компонент программного обеспечения Gigaset 
M34 Skype, который позволяют вести разговоры через переносной телефон.

Интернет-телефония: Voice over IP (VoIP)

С помощью программы Skypeвместо обычных телефонных соединений через 
телефонную сеть общего пользования вы можете устанавливать телефонные 
соединения через интернет (Voice over IP = VoIP). 

Обычно для установления такого соединения кроме интернет-соединения 
требуются два компьютера с звуковыми картами, колонками и микрофонами. Во 
время разговора абоненты обычно сидят за компьютерами. 

Используя адаптер Gigaset M34 USB, вы можете избежать физического 
соединения, зарегистрировав ваш беспроводной телефон как терминал для 
интернет телефонии. Для этого вы должны открыть диалог настройки компонента 
Skype, в программном обеспечении Gigaset M34 в выбрать нужный переносной 
телефон.

Смотри инструкции в разделе «Настройка Skype» на странице 48.

!
Программное обеспечение интернет-телефонии (Skype) дожно 
быть установлено и запущено Дополнитльную информацию вы 
найдете и руководстве пользователя Skype.

i

u Компонент Skype, программного обеспечения Gigaset M34 
предоставляет только интерфейс для выбора и настройки 
переносного телефона. Для использования интернет-телефонии 
должны быть установлена программа Skype. Эту программу 
можно загрузить из интернета.

u Установка, настройка и использование программы Skyp не 
относится к программному обеспечению Gigaset M34 и не 
описывается в настоящем руководстве. Дополнительную 
информацию вы можете найти в руководстве по использованию 
программы Skype. 

Общая информация о интернет-телефонии приведена в разделах:

u «Что такое Skype?» на странице 46.

http://www.skype.com
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Skype (интернет-телефония)

Меры предосторожности

Отказ от ответственности
Вы используете программу Skype на ваш собственный риск. 
Фирма Siemens Home and Office Communication Devices GmbH & Co. KG не несет 
никакой ответственности и не предоставляет никаких гарантий, связанных с 
использованием этой программы, включая ее совместное использование с 
другой продукцией.

Требования к системе для использования программы Skype 
Для высокого качества интернет-телефонии при использовании Skype 
рекомендуется использование компьютера, удовлетворяющего следующим 
минимальным требованиям:

u Операционная система Windows 2000 или Windows XP
u Процессор 1 ГГц

(мин. 400 МГц) 
u Оперативная память 256 МБ

(мин. 128 МБ)
u Свободное место в памяти 30 МБ 

(мин. 10 МБ)
u Оборудование для передачи звука: дуплексная звуковая карта и гарнитура

или Gigaset M34 USB
u Интернет-соединение: широкополосное, например, DSL 

(мин. модем 33.6 кбит/с)

Что такое Skype? 

Skype - это программное средство, позволяющее вам использовать компьютер 
для интернет-телефонии и передачи данных.

Skype использует имеющиеся компьютерные сети, например, интернет, для 
установления телефонного соединения между двумя или несколькими 
компьютерами или между вашим компьютером и телефоном проводной или 
мобильной сети. Соединения с использованием программы Skype основаны на 
технологии соединения равноправных узлов. Это означает, что для установления 
соединение не требуется центральный сервер. Соединяющиеся компьютеры и 
шлюзы сами оснащаются необходимыми сервисными программами. 

С помощью служб SkypeIn и SkypeOut можно устанавливать соединения с 
абонентами проводных и мобильных телефонных сетей. 

Программа Skype разработана компанией Skype Technologies SA, партнером 
фирмы Siemens Home and Office Communication Devices GmbH & Co. KG. 
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Программа Skype является бесплатной (freeware), т. е. ее можно легально 
передавать другим пользователям.

На прилагаемом компакт диске с программным обеспечением Gigaset M34 вы 
найдете специальную версию программы Skype. Использование этой версии 
гарантирует распознавание программы Skype переносным телефоном и 
возможность использования этой программы с вашего переносного телефона.

Преимущества
u При соединении двух компьютеров стоимость интернет-телефонии 

определяется только стоимостью подключения к интернету или стоимостью 
использования сети, других затрат нет - независимо от продолжительности 
соединения, количества абонентов и расстояния между абонентами. 

u Для вызовов абонентов сетей проводной связи через службу SkypeOut к 
стоимости доступа в интернет добавляется небольшой тариф. Как правило 
международные соединения стоят не дороже местных. Информацию о 
тарифах можно найти на интернет-сайте Skype.

u Технология соединения между равноправными узлами позволяет избежать 
перегрузки сети, так как соединение устанавливается децентрализовано 
между соединяемыми компьютерами.

u Skype обеспечивает очень высокое качество передачи речи. Качество 
соединения обычно ограничивается только возможностями соединяемых 
компьютеров (аппаратной конфигурацией).

u Телефонные соединения могут передаваться в зашифрованной форме, 
межсетевые экраны могут использоваться как обычно без ограничений.

Дополнительную информацию о программе Skype можно найти в интернете:

u http://www.skype.com 
u http://www.planetskype.de (на немецком языке).
Дальнейшую информацию вы можете найти в инструкции по Skype. Инструкция 
находится в папке gigaset-m34-software\manuals в формате PDF на диске, 
который вы получили при покупке адаптера M34 USB.

http://www.skype.com "target="_blank"
http://www.planetskype.de "target="_blank"
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Настройка Skype

Компонент Skype программного обеспечения Gigaset M34 используется 
исключительно для регистрации переносных телефонов для интернет-
телефонии. Интернет-телефония и телефонный справочник Skype должны 
настраиваться непосредственно в программе Skype.

ì Запустите программное обеспечение Gigaset M34 для настройки 
взаимодействия с программой интернет-телефонии Skype.

ì Выберите в дереве меню опцию Skype. В рабочей области выводится окно 
настройки компонента Skype. 

ì В поле Skype > Handset menu: укажите, должно ли дополнительное меню 
Skype выводиться в меню зарегистрированных переносных телефонов. 
Если эта опция выбрана, вы сможете вызывать из меню переносного 
телефона опции Skype, например, телефонный справочник Skype.

ì В поле Skype > Waiting messages должна ли информация Skype выводиться 
на дисплей во время установленных соединений, если получено другое 
сообщение.

ì В поле Handset выберите переносной телефон на котором должны 
сигнализироваться входящие вызовы VoIP. Вы можете выбрать только 
переносные телефоны, зарегистрированные на том же базовом блоке, что и 
адаптер Gigaset M34 USB.

ì Выберите в дереве меню другую опцию или завершите работу с программным 
обеспечением Gigaset M34. 
Новая настройка сохраняется. Зарегистрированные переносные телефоны 
могут использоваться для интернет-телефонии. 

Опция Краткое описание
None Входящие интернет-вызовы не сигнализируются на 

переносных телефонах.
All Входящие интернет-вызовы сигнализируются на всех 

переносных телефонах.
INT1 / INT2 / ... Входящие интернет-вызовы сигнализируются только на 

переносных телефонах с указанными названиями. 
Выбор нескольких опций невозможен.



49

Skype (интернет-телефония)

Gigaset M34 USB App / Russ / A31008-M403-R102-x4-5619 / Skype.fm / 03.08.2006
S

ch
ab

lo
ne

 2
00

5_
07

_2
7

Использование программы Skype с переносным 
телефоном

Если вы настроили компонент Skype, то вы можете пользоваться интернет-
телефонией с переносного телефона. Для этого вы должны установить 
внутреннее соединение между переносным телефоном и адаптером Gigaset M34 
USB.

Вызов адаптера Gigaset M34 USB

Для того чтобы соединение можно было установить, переносной телефон и 
адаптер Gigaset M34 USB должны быть зарегистрированы на одном базовом 
блоке. Для установления соединения между переносным телефоном и 
адаптером Gigaset M34 USB позвоните с переносного телефона на адаптер 
Gigaset M34 USB (внутренние соединения бесплатны). 

ì Нажмите клавишу INT на переносном телефоне.

ì Выберите внутреннего абонента Gigaset M34 USB. Внутреннее название, под 
которым адаптер зарегистрирован на базовом блоке, можно посмотреть в 
настройках программного обеспечения Gigaset M34 - M34 USB > 
Configuration > Name:.

ì Для установления внутреннего соединения нажмите на переносном телефоне 
клавишу соединения или клавишу громкой связи.

i
Соединения с абонентами сетей проводной связи можно 
устанавливать только при наличии учетной записи SkypeOut и 
положительном остатке на счете. Информацию о SkypeOut вы 
найдете на интернет-сайте Skype.

!

Учтите, что во время внутреннего соединения ваш переносной 
телефон будет заблокирован для других вызовов. 

Если вы включили на базовом блоке функцию ожидания вызова, то 
при поступлении вызова вы услышите специальный сигнал и на 
дисплей будет выведено имя или абонентский номер вызывающего 
абонента. Если при настройке компонента Skype вы выбрали 
опцию отображения входящих сообщений, то текстовые сообщения 
будут выводится на дисплей и во время соединений интернет-
телефонии. 
Входящие соединения VoIP не сигнализируются по время 
установленных соединений VoIP.
Дополнительную информацию вы найдете в инструкции по 
эксплуатации переносного телефона.
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Установление соединения

Меню адаптера M34 USB выводится на дисплей вашего переносного телефона. 
В этом меню вы увидите все функции, к которым вы можете получить доступ с 
переносного телефона.

ì Вызовите на переносном телефоне меню Skype.
На дисплей выводится список контактов Skype-/SkypeOut. Контакты 
сортируются по алфавиту. Для контактов Skype, находящихся в 
интерактивном режиме, после имени указывается галочка. Контакты Skype-
Out помечены символом „звезда“ (*). 
Вы можете:

Установление соединения с контактом Skype/SkypeOut
ì Выберите контакт. Поиск контактов в списке описан в разделе «Поиск 

контактов в списке Skype» на странице 51.

ì Нажмите клавишу соединения или клавишу громкой связи переносного 
телефона.

Вызов абонента проводной сети с помощью SkypeOut
ì Выберите запись Please dial и нажмите клавишу OK. 

ì Введите номер абонента проводной сети, которому вы хотите позвонить 

Если соединение вам больше не нужно:
ì Завершите соединение, нажав клавишу „отбой“ вашего переносного 

телефона.

Порядок контактов в списке Skype

При выборе в меню M34 USB на переносном телефоне пункта Skype на дисплей 
выводится список контактов Skype и SkypeOut, которые вы можете включить в 
контакт-лист с помощью программы Skype. Порядок сортировки:

1. Ваш собственный Skype-ID. 

2. Контакты SkypeOut, для которых введен абонентский номер, но не введено 
имя (начинаются с „+“ )

3. Контакты, начинающиеся с букв, в алфавитном порядке.

i
Для вызовов SkypeOut необходимо вводить номера с кодом страны 
(и для местных соединений). Для кода страны нужно вводить „00“ 
вместо „+“. 

Пример: 0049891234567

i На некоторых переносных телефонах диакритические знаки 
выводятся неправильно.
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Поиск контактов в списке Skype

Вы можете выбирать контакты в списке следующими способами: 

ì Вызовите на переносном телефоне меню Skype.
На дисплей выводится список контактов Skype и SkypeOut.

Вы можете:

ì Листать список, пока на дисплей не будет выведено нужное имя. 

Или: 

ì Ввести с помощью клавиатуры переносного телефона первую букву имени. 
На дисплей выводится первый контакт, начинающийся с этой буквы. Затем 
листайте список для выбора нужной записи.
Ввод специальных символов описан в инструкции по эксплуатации 
переносного телефона. 

Пример:
Вы хотите позвонить другу, который включен в список контактов Skype как „Ben“. 

ì Нажмите на переносном телефоне два раза клавишу 2. На дисплей 
выводится первое имя, начинающееся с буквы B: Barbara. Листайте список и 
выберите „Ben“. 

Вызовы с использованием списка соединений Skype

В списке соединений Skype сохраняются последние набранные номера. Этот 
список соответствует списку набранных номеров телефона. 

ì Вызовите на переносном телефоне меню Skype.

ì Нажмите на переносном телефоне дисплейную клавишу Log. 

ì Выберите номер и нажмите клавишу соединения/клавишу громкой связи 
переносного телефона или нажмите дисплейную клавишу Call. 
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Изменение своего статуса Skype

Вы можете изменить свой статус Skype с помощью переносного телефона. С 
помощью статуса вы можете указать, будете ли вы доступны для компьютерных 
телефонных соединений. Текущий статус виден другим пользователям системы. 

ì Вызовите на переносном телефоне меню Skype.

ì Выберите свой собственный Skype ID.

ì Нажмите клавишу Status.

ì Выберите статус (например, Stepped Out) и нажмите клавишу OK. 

Опрос статуса контактов

Вы можете опросить статус контактов. 

ì Вызовите на переносном телефоне меню Skype.

ì Выберите контакт, статус которого вы хотите опросить.

ì Нажмите дисплейную клавишу About. На дисплей выводится текущий статус 
контакта (например, Stepped Out).
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